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Innovations

ntro Stats, sixth edition, has been especially exciting to develop. The book you hold has

several innovations. Of course, we’ve kept our conversational style and anecdotes,! but

we’ve enriched that material with greater use of our signature tools for teaching about
randomness, sampling distribution models, and inference throughout the book. We’ve
added current discussions of ethical issues to each chapter. Each chapter now ends with
a student project suitable as a challenge for collaborative work. We’ve expanded discus-
sions of models for data to include models with more than two variables. We’ve taken our
inspiration both from our experience in the classroom and from the 2016 revision of the
Guidelines for Assessment and Instruction in Statistics Education (GAISE) report adopted
by the American Statistical Association. As a result, we increased the text’s innovative uses
of technology to encourage more statistical thinking, while maintaining its traditional core
concepts and coverage. You’ll notice that the order of topics is designed, to expand our
attention beyond just one or two variables.

Technology

The GAISE guidelines call on us to Use technology to explore concepts and analyze data.
We emphatically agree. We think a modern statistics text should recognize from the start
that statistics is practiced with technology. And so should our students. You won’t find
tedious calculations worked by hand. You will find equation forms that favor intuition over
calculation. You’ll find extensive use of real data—even large data sets. Throughout, you’ll
find a focus on statistical thinking rather than calculation. The question that motivates each
of our hundreds of examples is not “How do you calculate the answer?”” but “How do you
think about the answer?”

For this edition of Intro Stats we’ve taken this principle still further. We have har-
nessed technology to develop simulation tools to improve the learning of two of the most
difficult concepts in the introductory course: the idea of a sampling distribution and the
reasoning of statistical inference.

Multivariable Thinking and Multiple Regression

GAISE’s first guideline is to give students experience with multivariable thinking. The world
is not univariate, and relationships are not limited to two variables. The fifth edition of Intro
Stats introduced a third variable as early as Chapter 3’s discussion of contingency tables and
mosaic plots. The positive responses we’ve seen to this innovation, have led us to build on it.
Following the discussion of correlation and regression as a tool (that is, without inference)
in Chapters 6, 7, and 8, we introduce multiple regression in Chapter 9.

Multiple regression may be the most widely used statistical method, and it is certainly
one that students need to understand. It is easy to perform multiple regressions with any
statistics program, and the exercise of thinking about more than two variables is worth the
effort. We’ve added new material about interpreting what regression models say. The effec-
tiveness of multiple regression is immediately obvious and makes the reach and power of
statistics clear. The use of real data underscores the universal applicability of these methods.

When we return to regression in Chapter 20 to discuss inference, we can deal with
both simple and multiple regression models together. There is nothing different to discuss.
(For this reason we set aside the F-test and adjusted R?. Students can add those later if

'And footnotes
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PREFACE

they need them.) This course is an introduction to statistics. It isn’t necessary to learn all
the details of the methods and models. But it is important to come away with a sense of
the power and usefulness of statistics to solve real problems.

Innovative ways to teach the logic of statistical inference have received increasing
attention. Among these are greater use of computer-based simulations and resampling
methods (randomization tests and bootstrapping) to teach concepts of inference.

Bootstrap

The introduction to the new GAISE guidelines explicitly mentions the bootstrap method.
The bootstrap is not as widely available or as widely understood as multiple regression.
But it fits our presentation naturally. In this edition, we have expanded and made more
extensive use of our innovative, Random Matters feature. Random Matters elements
provide students with hands-on experience with randomness, randomization, and ways
statistics can use randomness. In early chapters they draw small samples repeatedly from
large populations to illustrate how the randomness introduced by sampling leads to both
sampling distributions and statistical reasoning for inference. But what can we do when
we have only one sample? The bootstrap provides a way to continue this line of thought,
now by re-sampling from the sample at hand.

Bootstrapping provides an elegant way to simulate sampling distributions that we
might not otherwise be able to see. And it does not require the assumption of Normality
expected by Student’s t-based methods. However, these methods are not as widely avail-
able or widely used in other disciplines, so they should not be the only—or even the
principal—methods taught. They may be able to enhance student understanding, but
instructors may wish to downplay them if that seems best for a class. We’ve placed these
sections strategically so that instructors can choose the level that they are comfortable with
and that works best with their course.

Real Data

GAISE recommends that instructors integrate real data with a context and purpose. More
and more high school math teachers are using examples from statistics to demonstrate
intuitively how a little bit of math can help us say a lot about the world. So our readers
expect statistics to be about real-world insights. Intro Stats keeps readers engaged and
interested because we show statistics in action right from the start. The exercises pose
problems of the kind likely to be encountered in real life and propose ways to think
about making inferences almost immediately—and, of course, always with real, up-to-
date data.

Let us be clear. Intro Stats comes with an archive of over 300 datasets used throughout
the book. The datasets are available online at the student resource site, in MyLab Statistics
and at the free site DASL.datadescription.com. Examples that use these datasets cite them
in the text. More than 700 of our exercises have a a tag next to them to indicate that the
dataset referenced in the exercise is available electronically. The exercise title or a note
provides the dataset title. Some exercises have a () tag to indicate that they call for the
student to generate random samples or use randomization methods such as the bootstrap.
Although we hope students will have access to computers, we provide ample exercises
with full computer output for students to read, interpret, and explain. We encourage stu-
dents to get the datasets and reproduce our examples using their statistics software, and
some of the exercises require that.

Ethics

GAISE also calls for discussions of ethical issues. In this edition, new discussions of
relevant ethical concerns are found in every chapter. We have chosen topics motivated by
current events and issues students will know about. These elements are good fodder for
classroom discussions.


http://dasl.datadescription.com/

PREFACE Xi

For example, the discussion on p. 77 addresses the conflict between offering survey
respondents the freedom to self-identify variables such as their gender, religion, race, or
political position and the challenge that poses for data privacy. Combinations of responses
can become so narrow that the individual’s identity can be inadvertently exposed. A widely
advertised “brain supplement” that claims to have laboratory-based proof of efficacy is the
subject of the Ethics Matters element on p. 521. Their posted test results show that they
were “p-hacking” to find significance where none existed in the original data. On p. 218,
we discuss troubling fact that some of the founders of Statistics, including Galton, Pearson,
and Fisher were proponents of eugenics.

Student Projects

Each chapter ends with a new student project. These can be the basis for more extensive
investigations by students working on their own. But they also have enough “meat” to sup-
port team efforts. Most require that students use computers to gather or to analyze data.
All expect the resulting product will include discussion and conclusions and thus be more
than just some numbers or P-values.

Streamlined Content

Following the GAISE recommendations, we’ve streamlined several parts of the course:
Introductory material is covered more rapidly. Today’s students have seen a lot of sta-
tistics in their K—12 math courses and in their daily contact with online and print news
sources. We still cover the topics to establish consistent terminology (such as the difference
between a histogram and a bar chart). Chapter 2 does most of the work that previously
took two chapters.

The discussion of random variables and probability distributions is shorter than in
previous editions—again, a GAISE recommendation. Those are interesting topics, but
they are not needed in this course. We leave them for a later course for those students
who want to go further.

The Random Matters features show students that statistics vary from sample to sample,
show them (empirical) sampling distributions, note the effect of sample size on the shape
and variation of the sampling distribution of the mean, and suggest that it looks Normal. As
a result, the discussion of the Central Limit Theorem is transformed from the most difficult
one in the course to a relatively short discussion (“What you think is true about means really
is true; there’s this theorem.”) that can lead directly to the reasoning of confidence intervals.

Finally, introducing multiple regression doesn’t really add much material to the lesson
on inference for multiple regression because little is new.

GAISE 2016

As we’ve said, all of these enhancements follow the new Guidelines for Assessment
and Instruction in Statistics Education (GAISE) 2016 report adopted by the American
Statistical Association:

1. Teach statistical thinking.

¢ Teach statistics as an investigative process of problem-solving and decision-making.
¢ Give students experience with multivariable thinking.

Focus on conceptual understanding.

Integrate real data with a context and purpose.

Foster active learning.

Use technology to explore concepts and analyze data.

6. Use assessments to improve and evaluate student learning.

kW

The result is a course that is more aligned with the skills needed in the 21st century, one
that focuses even more on statistical thinking and makes use of technology in innovative
ways, while retaining core principles and topic coverage.
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Chapter Order

The challenge has been to use this modern point of view to improve learning without
discarding what is valuable in the traditional introductory course. Many first statistics
courses serve wide audiences of students who need these skills for their own work in dis-
ciplines where traditional statistical methods are, well, traditional. So we have not reduced
our emphasis on the concepts and methods you expect to find in our texts.

Our Approach

We’ve streamlined the presentation of basic topics that most students have already seen.
Pie charts, bar charts, histograms, and summary statistics all appear in Chapter 2. Chapter 3
introduces contingency tables, and Chapter 4 discusses comparing distributions. Chapter 5
introduces the Normal model and the 68-95-99.7 Rule. The four chapters of Part II then
explore linear relationships among quantitative variables—but here we introduce only the
models and how they help us understand relationships. We leave the inference questions until
later in the book. Part III discusses how data are gathered by survey and experiment.

In Part IV, Chapter 12 introduces basic probability and prepares us for inference.
Naturally, a new approach to teaching inference has led to a reorganization of inference
topics. In Chapter 13 we introduce confidence intervals for proportions as soon as we’ve
reassured students that their intuition about the sampling distribution of proportions is cor-
rect. Chapter 14 formalizes the Central Limit Theorem and introduces Student’s # models.
Chapter 15 is then about testing hypotheses, and Chapter 16 elaborates further, discussing
alpha levels, Type I and Type II errors, power, and effect size. The subsequent chapters in
Part V deal with comparing groups (both with proportions and with means), paired sam-
ples, chi-square, and finally, inferences for regression models (both simple and multiple).

We’ve found that one of the challenges students face is how to know what technique
to use when. In the real world, questions don’t come at the ends of the chapters. So, as
always, we’ve provided summaries at the end of each part along with a series of exer-
cises designed to stretch student understanding. These Part Reviews are a mix of ques-
tions from all the chapters in that part. Finally, we’ve added an extra set of “book-level”
review problems at the end of the text. These ask students to integrate what they’ve
learned from the entire course. The questions range from simple questions about what
method to use in various situations to more complete data analyses from real data. We
hope that these will provide a useful way for students to organize their understanding at
the end of the course.

We’ve discussed how this book is different, but there are some things we haven’t changed.

¢ Readability. This book doesn’t read like other statistics texts. Our style is both collo-
quial and informative, engaging students to actually read the book to see what it says.

¢ Humor. You will find quips and wry comments throughout the narrative, in margin
notes, and in footnotes.

¢ Informality. Our informal diction doesn’t mean that we treat the subject matter lightly
or informally. We try to be precise and, wherever possible, we offer deeper explana-
tions and justifications than those found in most introductory texts.

¢ Focused lessons. The chapters are shorter than in most other texts so that instructors
and students can focus on one topic at a time.

¢ Consistency. We try to avoid the “do what we say, not what we do” trap. Having taught
the importance of plotting data and checking assumptions and conditions, we model
that behavior through the rest of the book. (Check out the exercises in Chapter 20.)
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¢ The need to read. Statistics is a consistent story about how to understand the world
when we have data. The story can’t be told piecemeal. This is a book that needs to
be read, so we’ve tried to make the reading experience enjoyable. Students who start
with the exercises and then search back for a worked example that looks the same but
with different numbers will find that our presentation doesn’t support that approach.

Mathematics

Mathematics can make discussions of statistics concepts, probability, and inference clear
and concise. We don’t shy away from using math where it can clarify without intimidat-
ing. But we know that some students are discouraged by equations, so we always provide
a verbal description and a numerical example as well.

Nor do we slide in the opposite direction and concentrate on calculation. Although
statistics calculations are generally straightforward, they are also usually tedious. And,
more to the point, today, virtually all statistics are calculated with technology. We have
selected the equations that focus on illuminating concepts and methods rather than for
hand calculation. We sometimes give an alternative formula, better suited for hand cal-
culation, for those who find that following the calculation process is a better way to learn
about the result.

Technology and Data

We assume that computers and appropriate software are available—at least for demonstra-
tion purposes. We hope that students have access to computers and statistics software for
their analyses. We make more extensive use of special applications to demonstrate proper-
ties of randomness, illustrate the concept of a sampling distribution, and offer bootstrap
methods for inference. These applications can be found in MyLab Statistics and at astools.
datadesk.com.

We discuss generic computer output at the end of most chapters, but we don’t adopt
any particular statistics software. The Tech Support sections at the ends of chapters offer
guidance for seven common software platforms: Data Desk, Excel, JIMP, Minitab, SPSS,
StatCrunch, and R. We also offer some advice for TI-83/84 Plus graphing calculators,
although we hope that those who use them will also have some access to computers and
statistics software.

We don’t limit ourselves to small, artificial data sets, but base most examples and
exercises on real data with a moderate number of cases. Machine-readable versions of the
data are available at the Pearson Math & Stats Resource Site, MyLab Statistics, and at
dasl.datadescription.com.

Enhancing Understanding

Where Are We Going? Each chapter starts with a paragraph that raises the kinds of ques-
tions we deal with in the chapter. A chapter outline organizes the major topics and sections.

Random Matters. These innovative features travel along a progressive path of under-
standing randomness and our data. The first Random Matters element begins our think-
ing about drawing inferences from data. Subsequent Random Matters draw histograms
of sample means, introduce the thinking involved in permutation tests, and encourage
judgment about how likely the observed statistic seems when viewed against the simu-
lated sampling distribution of the null hypothesis (without, of course, using those terms).
Later Random Matters elements lead students through bootstrap calculations and compare
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bootstrap results to classical inference. The Random Matters elements have been rewritten
and expanded to provide step-by-step guidance.

New! Ethics Matters. This feature introduces relevant ethical considerations. Each chap-
ter has an ethics discussion. These discuss current ethical issues. All are good material for
classroom discussion, which we encourage.

New! Student projects. Each chapter ends with a student project that uses the methods
learned thus far. They can be used for individual work or as a basis for team projects.

Reality Check. We regularly remind students that statistics is about understanding the
world with data. Results that make no sense are probably wrong, no matter how carefully
we think we did the calculations. Mistakes are often easy to spot with a little thought, so
we ask students to stop for a reality check before interpreting their result.

Notation Alert. Throughout this book, we emphasize the importance of clear communica-
tion, and proper notation is part of the vocabulary of statistics. We’ve found that it helps
students when we are clear about the letters and symbols statisticians use to mean very
specific things, so we’ve included Notation Alerts whenever we introduce a special nota-
tion that students will see again.

Each chapter ends with several elements to help students study and consolidate what
they’ve seen in the chapter.

¢ Connections specifically ties the new topics to those learned in previous chapters.

¢ What Can Go Wrong? sections highlight the most common errors that people make
and the misconceptions they have about statistics. One of our goals is to arm students
with the tools to detect statistical errors and to offer practice in debunking misuses of
statistics, whether intentional or not.

¢ Next, the Chapter Review summarizes the story told by the chapter and provides a
bullet list of the major concepts and principles covered.

¢ A Review of Terms is a glossary of all of the special terms introduced in the chap-
ter. In the text, these are printed in bold and underlined. The Review provides page
references, so students can easily turn back to a full discussion of the term if the brief
definition isn’t sufficient.

The Tech Support section provides the commands in each of the supported statistics pack-
ages that deal with the topic covered by the chapter. These are not full documentation, but
should be enough to get a student started in the right direction.

Learning by Example

Step-by-Step Examples. We have updated the examples in our innovative Step-by-Step
feature. Each one provides a longer, worked example that guides students through the
process of analyzing a problem. The examples follow our three-step Think, Show, Tell
organization for approaching a statistics task. They are organized with general explana-
tions of each step on the left and a worked-out solution on the right. The right side of the
grid models what would be an “A” level solution to the problem. Step-by-Steps illustrate
the importance of thinking about a statistics question (What do we know? What do we
hope to learn? Are the assumptions and conditions satisfied?) and reporting our findings
(the Tell step). The Show step contains the mechanics of calculating results and conveys
our belief that it is only one part of the process. Our emphasis is on statistical thinking, and
the pedagogical result is a better understanding of the concept, not just number crunching.

Examples. As we introduce each important concept, we provide a focused example that
applies it—usually with real, up-to-the-minute data. Many examples carry the discussion
through the chapter, picking up the story and moving it forward as students learn more
about the topic.
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Just Checking. Just Checking questions are quick checks throughout the chapter; most
involve very little calculation. These questions encourage students to pause and think about
what they’ve just read. The Just Checking answers are at the end of the exercise sets in
each chapter so students can easily check themselves.

Assessing Understanding

Our Exercises have some special features worth noting. In the initial exercises, you’ll
find relatively simple, focused problems organized by chapter section. After that come
more extensive exercises that may deal with topics from several parts of the chapter or
even from previous chapters as they combine with the topics of the chapter at hand. All
exercises appear in pairs. The odd-numbered exercises have answers in the back of student
texts. Each even-numbered exercise hits the same topic (although not in exactly the same
way) as the previous odd exercise. But the even-numbered answers are not provided. If a
student is stuck on an even exercise, looking at the previous odd one (and its answer) can
often provide the help needed.

As stated previously, more than 700 of our exercises include datasets a and ran-
domization methods (:) available electronically. To ensure every student is able to read,
analyze, interpret, and communicate data findings, we also provide ample exercises with
full computer output.

We place all the exercises—including section-level exercises—at the end of the chap-
ter. Our writing style is colloquial and encourages reading. We are telling a story about
how to understand the world when you have data. Interrupting that story with exercises
every few pages would encourage a focus on the calculations rather than the concepts.

Part Reviews. The book is partitioned into five conceptual parts; each ends with a Part
Review. The part review discusses the concepts in that part of the text, tying them together
and summarizing the story thus far. Then there are more exercises. These exercises have
the advantage (for study purposes) of not being tied to a chapter, so they lack the hints of
what to do that would come from that identification. That makes them more like potential
exam questions and a good tool for review. Unlike, the chapter exercises, these are not
paired.

Parts I-V Cumulative Review Exercises. A final book-level review section appears after
the Part Review V. Cumulative Review exercises are longer and cover concepts from the
book as a whole.

Additional Resources Online

Most of the supporting materials can be found online:

At the Pearson Math & Stats Resource Site
Within the MyLab Statistics course at pearson.com/mylab/statistics
Datasets are also available at dasl.datadesk.com.

Simulation and bootstrap applications (along with a few others) are available at MyLab
Statistics and at astools.datadescription.com

Data desk RP is a statistics program with a graphical interface that is easy to learn and
use. A student version is available at datadesk.com. Click on the Teachers & Students
tab at the top of the page. Students beginning with the R statistics language may find it
helpful to use Data desk’s ability to write out R code for plots and analyses such as those
used in the text, thereby providing a graphical interface that can be easier for beginners.
Students accessing datasets at DASL will find a quick link to Data desk.
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StatCrunch™

StatCrunch is powerful web-based statistical software that allows users to perform com-
plex analyses, share data sets, and generate compelling reports of their data. The vibrant
online community offers tens of thousands shared data sets for students to analyze.

¢ Collect. Users can upload their own data to StatCrunch or search a large library of
publicly shared data sets, spanning almost any topic of interest. Also, an online survey
tool allows users to quickly collect data via web-based surveys.

¢ Crunch. A full range of numerical and graphical methods allow users to analyze and gain
insights from any data set. Interactive graphics help users understand statistical concepts
and are available for export to enrich reports with visual representations of data.

¢ Communicate. Reporting options help users create a wide variety of visually appeal-
ing representations of their data.

Full access to StatCrunch is available with a MyLab Statistics kit, and StatCrunch is available
by itself to qualified adopters. StatCrunch Mobile is also now available when you visit
www.statcrunch.com from the browser on your smartphone or tablet. For more informa-
tion, visit www.StatCrunch.com or contact your Pearson representative.

Additional Resources

Minitab® and Minitab ExpressTM make learning statistics easy and provide students
with a skill-set that’s in demand in today’s data driven workforce. Bundling Minitab®
software with educational materials ensures students have access to the software they
need in the classroom, around campus, and at home. And having the latest version of
Minitab ensures that students can use the software for the duration of their course. ISBN 13:
978-0-13-445640-9 ISBN 10: 0-13-445640-8 (Access Card only; not sold as standalone.)

JMP Student Edition is an easy-to-use, streamlined version of JMP desktop statistical
discovery software from SAS Institute, Inc. and is available for bundling with the text.
ISBN-13: 978-0-13-467979-2; ISBN-10: 0-13-467979-2
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MyLab® Statistics Online Course for Intro Stats, 6e
by Richard D. De Veaux, Paul F. Velleman,
and David E. BOCk(access code required)

MyLab Statistics is available to accompany Pearson’s market-leading text options,
including Intro Statistics, 6e by De Veaux/Velleman/Bock (access code required).
MyLab™ is the teaching and learning platform that empowers you to reach every
student. MyLab Statistics combines trusted author content—including full eText
and assessment with immediate feedback—with digital tools and a flexible plat-
form to personalize the learning experience and improve results for each student.
Integrated with StatCrunch®, an web-based statistical software program, students
learn the skills they need to interact with data in the real world.
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New exercises that

incorporate REAL DATA.

MyLab Statistics exercises have been updated to
include real data so students can understand the
real-world implications of data analysis. Homework
reinforces and supports students’ understanding of
key statistics topics within a real world context.
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Enhanced applications aid visualization
and statistical understanding.

Applications have been updated and integrated into the Ran-
dom Matters features and end of section problems. Students
utilize applications to demonstrate randomness and illustrate
sampling distributions through randomization techniques
like bootstrapping. App problems have been created in the
MyLab Statistics homework so students can think statistically
about the output and communicate their understanding.
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Examples and exercises throughout the textbook and MyLab

Statistics use diverse and relevant data to help students un- i
derstand how statistics applies to inclusive everyday life.
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Student Resources

Intro Stats, 6th edition is part of De Veaux,
Velleman, and Bock’s Statistics series (ISBN-13:
978-0-13-680686-8; ISBN-10: 0-13-680686-4) This
print textbook is available for students to rent for
their classes.

Student’s Solutions Manual provides detailed,
worked-out solutions to odd-numbered exercises.
This manual is available within MyLab Statistics.

Instructor Resources

Instructor’s Solutions Manual (Download Only),
contains solutions to all the exercises. These files are
available to qualified instructors through Pearson
Education’s online catalog at www.pearson.com or
within MyLab Statistics.

Online Test Bank and Resource Guide
(Download Only), includes chapter-by-chapter
comments on the major concepts, tips on pre-
senting topics, extra teaching examples, a list of
resources, chapter quizzes, part-level tests, and
suggestions for projects. These files are available
to qualified instructors through Pearson Educa-
tion’s online catalog at www.pearson.com or within
MyLab Statistics.

TestGen® Computerized Test Bank (www
.pearsoned.com/testgen) enables instructors to

Resources for Success

P

build, edit, print, and administer tests using a
computerized bank of questions developed to
cover all the objectives of the text. TestGen is
algorithmically based, allowing instructors to
create multiple but equivalent versions of the
same question or test with the click of a button.
Instructors can also modify test bank questions or
add new questions. The software and test bank are
available for download from Pearson Education’s
online catalog at www.pearson.com.

PowerPoint® Lecture Slides: Free to qualified
adopters, this classroom lecture presentation
software is geared specifically to the sequence
and philosophy of the book. Key graphics from
the book are included to help bring the statistical
concepts alive in the classroom. These files are
available to qualified instructors through
Pearson Education’s online catalog at www
.pearson.com or within MyLab Statistics.

Learning Catalytics: Learning Catalytics is a
web-based engagement and assessment tool.

As a “bring-your-own-device” direct response
system, Learning Catalytics offers a diverse library
of dynamic question types that allow students to
interact with and think critically about statistical
concepts. As a real-time resource, instructors can
take advantage of critical teaching moments in the
classroom or through assignable and gradeable
homework.

pearson.com/mylab/statistics

Pearson
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1.3 Variables

1.4 Models

But where shall |
begin?” asked Alice. “Begin
at the beginning,” the King
said gravely, “and go on till
you come to the end: then
stop.

—Lewis Carroll,

Alice’s Adventures
in Wonderland

Stats Starts
Here

WHERE ARE WE GOING?

Statistics gets no respect. People say things
like “You can prove anything with statistics.”
People will write off a claim based on data as
“just a statistical trick.” And statistics courses
don’t have the reputation of being students’
first choice for a fun elective.

But statistics is fun. That’s probably not what
you heard on the street, but it’s true. Statistics is
the science of learning from data. A little practice
thinking statistically is all it takes to start seeing
the world more clearly and accurately.

This is a book about understanding the
world by using data. So we’d better start by
understanding data. There’s more to that than
you might have thought.

KB} What Is Statistics?

People around the world have one thing in common—they all want to figure out what’s
going on. You’d think with the amount of information available to everyone today this
would be an easy task, but actually, as the amount of information grows, so does our need
to understand what it can tell us.

At the heart of all this information, on the Internet and all around us, are data. We’ll talk
about data in more detail in the next section, but for now, think of data as any collection
of numbers, characters, images, or other items that provide information about something.
What sense can we make of all these data? You certainly can’t make a coherent picture from
random pieces of information. Whenever there are data and a need for understanding the
world, you’ll find statistics.

This book will help you develop the skills you need to understand and communicate
the knowledge that can be learned from data. By thinking clearly about the question you’re
trying to answer and learning the statistical tools to show what the data are saying, you’ll
acquire the skills to tell clearly what it all means. Our job is to help you make sense of the
concepts and methods of statistics and to develop a powerful, effective approach to under-
standing the world through data.

'We were thinking of calling this chapter “Introduction” but nobody reads the introduction, and we wanted you
to read this. We feel safe admitting this down here in the footnotes because nobody reads footnotes either.
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Data is king at Amazon.
Clickstream and purchase
data are the crown jewels at
Amazon. They help us build
features to personalize the
Web site experience.

—Ronny Kohavi,
former Director of Data

Mining and Personalization,
Amazon.com

What is statistics?

Statistics is a way of
reasoning, along with a
collection of tools and
methods, designed to help
us understand the world.

>0

What are statistics?

>0

Statistics (plural) are
particular calculations made
from data.

So what is data?

: You mean “what are data?”
Data is the plural form. The
singular is datum.

: OK, OK, so what are data?

: Data are values along with
their context.

>

>

The ads say, “Don’t drink
and drive; you don’t want to
be a statistic.” But you can’t
be a statistic.

We say, “Don’t be a
datum.”

Data vary. Ask different people the same question and you’ll get a variety of answers.
Statistics helps us to make sense of the world described by our data by seeing past the
underlying variation to find patterns and relationships. This book will teach you skills to
help with this task and ways of thinking about variation that are the foundation of sound
reasoning about data.

Consider the following:

¢ If you have a Facebook account, you have probably noticed that the ads you see online
tend to match your interests and activities. Coincidence? Hardly. According to Wired
magazine,” much of your personal information has probably been sold to marketing
or tracking companies. Why would Facebook give you a free account and let you
upload as much as you want to its site? Because your data are valuable! Using your
Facebook profile, a company might build a profile of your interests and activities:
what movies and sports you like; your age, gender, education level, and hobbies;
where you live; and, of course, who your friends are and what they like. From Face-
book’s point of view, your data are a potential gold mine. Gold ore in the ground is
neither very useful nor pretty. But with skill, it can be turned into something both
beautiful and valuable. What we’re going to talk about in this book is how you can
mine your own data and learn valuable insights about the world.

¢ Americans spend an average of 4.9 hours per day on their smartphones. About 9.4 trillion
text messages are sent each year.> Some of these messages are sent or read while the
sender or the receiver is driving. How dangerous is texting while driving?

How can we study the effect of texting while driving? One way is to measure
reaction times of drivers faced with an unexpected event while driving and texting.
Researchers at the University of Utah tested drivers on simulators that could present
emergency situations. They compared reaction times of sober drivers, drunk drivers,
and texting drivers.* The results were striking. The texting drivers actually responded
more slowly and were more dangerous than drivers who were above the legal limit for
alcohol.

In this book, you’ll learn how to design and analyze experiments like this. You’ll
learn how to interpret data and to communicate the message you see to others. You’ll also
learn how to spot deficiencies and weaknesses in conclusions drawn by others that you see
in newspapers and on the Internet every day. Statistics can help you become a more
informed citizen by giving you the tools to understand, question, and interpret data.

Zhttp://www.wired.com/story/wired-guide-personal-data-collection/
3https://www.textrequest.com/blog/texting-statistics-answer-questions/

4<Text Messaging During Simulated Driving,” Drews, F. A., et al., Human Factors: hfs.sagepub.com/
content/51/5/762
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EF3 Data

STATISTICS IS ABOUT ...

# Variation: Data vary
because we don’t see
everything, and even what
we do see, we measure
imperfectly.

# Learning from data: We
hope to learn about the
world as best we can
from the limited, imperfect
data we have.

¢ Making intelligent deci-
sions: The better we
understand the world, the
wiser our decisions will be.
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Amazon.com opened for business in July 1995, billing itself as “Earth’s Biggest Book-
store.” By 1997, Amazon had a catalog of more than 2.5 million book titles and had sold
books to more than 1.5 million customers in 150 countries. In 2019, the company’s sales
reached almost $280.5 billion (more than 22% over the previous year). Amazon has sold a
wide variety of merchandise, including a $400,000 necklace, yak cheese from Tibet, and
the largest book in the world. How did Amazon become so successful and how can it
keep track of so many customers and such a wide variety of products? The answer to both
questions is data.

But what are data? Think about it for a minute. What exactly do we mean by “data”?
You might think that data have to be numbers, but data can be text, pictures, web pages,
and even audio and video. If you can sense it, you can measure it. The amount of data col-
lected in the world is growing exponentially.’

Let’s look at some hypothetical values that Amazon might collect:

B0O000010AA | 0.99 Chris G. 902 105-2686834- | 1.99 0.99 Illinois
3759466

Los Angeles | Samuel R. Ohio N B000068ZvVQ | Amsterdam New York, New York | Katherine H.

Katherine H. | 002-1663369-6638649 | Beverly Hills N N 103-2628345-9238664 | 0.99 Massachusetts

312 Monique D. 105-9318443-4200264 | 413 B00000I5Y6 | 440 B000002BK9 0.99

Canada Detroit 440 105-1372500-0198646 | N B002MXA7Q0 Ohio Y

Try to guess what they represent. Why is that hard? Because there is no context. If we
don’t know what values are measured and what is measured about them, the values are
meaningless. We can make the meaning clear if we organize the values into a data table
such as this one:

Order Number Name State/Country Price Area Code Download Gift? ASIN Artist
105-2686834-3759466 Katherine H. | Ohio 0.99 440 Amsterdam N B0000015Y6 Cold Play
105-9318443-4200264 Samuel R lllinois 1.99 312 Detroit Y B000002BK9 Red Hot Chili Peppers
105-1372500-0198646 Chris G. Massachusetts 0.99 413 New York, N B0000682vVQ Frank Sinatra

New York
103-2628345-9238664 Monique D. Canada 0.99 902 Los Angeles B0000010AA Blink 182
002-1663369-6638649 Katherine H. | Ohio 0.99 440 Beverly Hills B0O02MXA7Q0 Weezer

Now we can see that these are purchase records for album download orders from Amazon.
The column titles tell what has been recorded. Each row is about a particular purchase.

What information would provide a context? Newspaper journalists know that the lead
paragraph of a good story should establish the “Five W’s”: who, what, when, where, and
(if possible) why. Often, we add how to the list as well. The answers to the first two ques-
tions are essential. If we don’t know what values are measured and who those values are
measured on, the values are meaningless.

You should always stop to consider the ethical issues around collecting, managing,
visualizing, and analyzing data. Throughout this text, we’ll present ethics discussions and
examples. Because these are real examples, each is complex and has no one right solution.
We hope they stimulate further discussion in and out of class.

SBut not at a rate that researchers seem to be able to agree upon. It may be doubling every year or growing by as
much as ten-fold every two years, depending on whom you believe.


http://amazon.com/

4

PART |

DATA BEATS INTUITION

Amazon monitors and
updates its website to better
serve customers and maxi-
mize sales. To decide which
changes to make, analysts
experiment with new designs,
offers, recommendations,
and links. Statisticians want
to know how long you’ll
spend browsing the site

and whether you’ll follow
the links or purchase the
suggested items. As

Ronny Kohavi, former
director of Data Mining and
Personalization for Amazon,
said, “Data trumps intuition.
Instead of using our intuition,
we experiment on the live
site and let our customers
tell us what works for them.”

Exploring and Understanding Data

Who and What

In general, the rows of a data table correspond to individual cases about whom (or about
which, if they’re not people) we record some characteristics. Cases go by different names,
depending on the situation.

¢ Individuals who answer a survey are called respondents.

¢ People on whom we experiment are subjects or (to acknowledge the importance of
their role in the experiment) participants.

¢ Animals, plants, websites, and other inanimate subjects are often called experimental units.

¢ Often we simply call cases what they are: for example, customers, economic quarters,
or companies.

¢ In a database, rows are called records—in this example, purchase records. Perhaps the
most generic term is cases; but in any event the rows represent the Who of the data.

Look at all the columns to see exactly what each row refers to. Here the cases are dif-
ferent purchase records. You might have thought that each customer was a case, but notice
that, for example, Katherine H. appears twice, in both the first and the last row. A com-
mon place to find out exactly what each row refers to is the leftmost column. That value
often identifies the cases; in this example, it’s the order number. If you collect the data
yourself, you’ll know what the cases are. But, often, you’ll be looking at data that some-
one else collected and you’ll have to ask or figure that out yourself.

Often the cases are a sample from some larger population that we’d like to under-
stand. Amazon doesn’t care about just these customers; it wants to understand the buying
patterns of all its customers, and, generalizing further, it wants to know how to attract
other Internet users who may not have made a purchase from Amazon’s site. To be able to
generalize from the sample of cases to the larger population, we’ll want the sample to be
representative of that population—a kind of snapshot image of the larger world.

L ETHICS MATTERS

In the United States, the Belmont Report® is the main federal document that provides the
“Ethical Principles and Guidelines for the Protection of Human Subjects of Research.”
The three fundamental ethical principles for using any human subjects for research are:

1. Respect for persons: The autonomy of all people should be protected. They
should be treated with courtesy and respect and provided informed consent.
Researchers must be truthful and conduct no deception.

2. Beneficence: The analyst must “do no harm” while maximizing benefits for the
research project and minimizing risks to the research subjects.

3. Justice: There must be reasonable, nonexploitative, and well-considered proce-
dures, administered fairly—a fair distribution of costs and benefits to potential
research participants—and equally.

Respect for Persons

Data collection should respect a person’s identify, including their gender identity.
Although non-binary gender and gender fluidity are becoming more widely
accepted in Western societies, diversity in gender identity is not new. Many indige-
nous cultures and other societies have recognized more than two genders through-
out history. In the past few years gender fluidity has become increasingly important
and prevalent. A 2016 Harris poll found that 1% of all millennials in the US identify
as bigender. In that same year, Jamie Shupe became the first person in the US to
be granted official non-binary gender status.

6https://www.hhs.gov/ohrp/regulations—and—policy/belmont—report/index.html
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However, government agencies worldwide have been slow to adapt their data
collection procedures. An informal survey of agencies such as the United Nations,
the World Health Organization, the 2020 US Census, the Centers for Disease
Control shows that (at least until very recently) they collect gender data with only
binary choices. We continue to use these data as collected, and they appear in this
text in the way they are reported. Among the reasons for continuing to use them is
that they are vital for the continuing study of the economic and health-related
inequality experienced by women.

As new data are collected more gender options will appear. If you collect your
own data, you should certainly take a more inclusive approach. But realize that
there are many data sets with important information that currently have only binary
choices and that this situation may only evolve slowly.

We must know who and what to analyze data. Without knowing these two, we don’t
have enough information to start. Of course, we’d always like to know more. The more we
know about the data, the more we’ll understand about the world. If possible, we’d like to
know the when and where of data as well. Values recorded in 1803 may mean something
different than similar values recorded last year. Values measured in Tanzania may differ
in meaning from similar measurements made in Mexico. And knowing why the data were
collected can tell us much about their reliability and quality.

How the Data Are Collected

How the data are collected can make the difference between insight and nonsense. As we’ll see
later, data that come from a voluntary survey on the Internet are almost always worthless. One
primary concern of statistics, to be discussed in Part II1, is the design of sound methods for col-
lecting data. Throughout this book, whenever we introduce data, we’ll provide a margin note
listing the W’s (and H) of the data. Identifying the W’s is a habit we recommend.

The first step of any data analysis is to know what you are trying to accomplish and
what you want to know. To help you use statistics to understand the world and make deci-
sions, we’ll lead you through the entire process of thinking about the problem, showing
what you’ve found, and telling others what you’ve learned. Every guided example in this
book is broken into these three steps: Think, Show, and Tell. Identifying the problem and
the who and what of the data is a key part of the Think step of any analysis. Make sure you
know these before you proceed to Show or Tell anything about the data.

EXAMPLE 1.1

Identifying the Who

Consumer Reports published an evaluation of 126 tablets from a variety of
manufacturers.

QUESTION: Describe the population of interest, the sample, and the Who of the study.

ANSWER: The magazine is interested in the performance of tablets currently offered
for sale. It tested a sample of 126 tablets, which are the Who for these data. Each
tablet selected represents all similar tablets offered by that manufacturer.

The characteristics recorded about each individual are called variables. They are usually
found as the columns of a data table with a name in the header that identifies what has
been recorded. In the Amazon data table we find the variables Order Number, Name,
State/Country, Price, and so on.
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Far too many scientists
have only a shaky grasp of
the statistical techniques they
are using. They employ them
as an amateur chef employs
a cookbook, believing the
recipes will work without
understanding why. A more
cordon bleu attitude . . .
might lead to fewer statistical
soufflés failing to rise.

—The Economist,

June 3, 2004, “Sloppy
stats shame science”

Categorical Variables

Some variables just tell us what group or category each individual belongs to. Do you
wear glasses or not? Are you pierced or not? We call variables like these categorical, or
qualitative variables. (You may also see them called nominal variables because they
name categories.) Some variables are clearly categorical, like the variable State/Country.
Its values are text and those values tell us what category the particular case falls into. But
numerals are often used to label categories, so categorical variable values can also be
numerals. For example, Amazon collects telephone area codes that categorize each phone
number into a geographical region. So area code is considered a categorical variable even
though it has numeric values. (But see the story in the following box.)

AREA CODES—NUMBERS OR CATEGORIES?

The What and Why of area codes are not as simple as they may first seem. When area
codes were first introduced, AT&T was still the source of all telephone equipment, and
phones had dials.

To reduce wear and tear on the dials, the area codes with the lowest digits (for
which the dial would have to spin least) were assigned to the most populous
regions—those with the most phone numbers and thus the area codes most likely to
be dialed. New York City was assigned 212, Chicago 312, and Los Angeles 213, but
rural upstate New York was given 607, Joliet was 815, and San Diego 619. For that
reason, at one time the numerical value of an area code could be used to guess
something about the population of its region. Since the advent of push-button
phones, area codes have finally become just categories.

Descriptive responses to questions are often categories. For example, the responses to
the questions “Who is your cell phone provider?”” and “What is your marital status?” yield
categorical values. When Amazon considers a special offer of free shipping to customers,
it might first analyze how purchases have been shipped in the recent past. Amazon might
start by counting the number of purchases shipped in each category: ground transporta-
tion, second-day air, and next-day air. Counting is a natural way to summarize a categori-
cal variable such as Shipping Method. Chapters 2 and 3 discuss summaries and displays of
categorical variables more fully.

Quantitative Variables

When a variable contains measured numerical values with measurement units, we call it a
quantitative variable. Quantitative variables typically record an amount or degree of
something. For a quantitative variable, its measurement units provide a meaning for the
numbers. Even more important, units such as yen, cubits, carats, angstroms, nanoseconds,
miles per hour, or degrees Celsius tell us the scale of measurement, so we know how far
apart two values are. Without units, the values of a measured variable have no meaning. It
does little good to be promised a raise of 5000 a year if you don’t know whether it will be
paid in Euros, dollars, pennies, yen, or Mauritanian Ouguiya (MUR).7

Sometimes a variable with numeric values can be treated as either categorical or
quantitative depending on what we want to know from it. Amazon could record your Age
in years. That seems quantitative, and it would be if the company wanted to know the
average age of those customers who visit their site after 3 a.m. But suppose Amazon wants
to decide which album to feature on its site when you visit. Then thinking of your age in
one of the categories Child, Teen, Adult, or Senior might be more useful. So, sometimes
whether a variable is treated as categorical or quantitative is more about the question we
want to ask rather than an intrinsic property of the variable itself.

As of 3/21/2020 $1 = 37.32 MUR
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Identifiers

For a categorical variable like Survived, each individual is assigned one of two possible
values, say Alive or Dead®. But for a variable with ID numbers, such as a student ID,
each individual receives a unique value. We call a variable like this, which has exactly
as many values as cases, an identifier variable. Identifiers are useful, but not typically
for analysis.

Amazon wants to know who you are when you sign in again and doesn’t want to con-
fuse you with some other customer. So it assigns you a unique identifier. Amazon also
wants to send you the right product, so it assigns a unique Amazon Standard Identification
Number (ASIN) to each item it carries. You’ll want to recognize when a variable is play-
ing the role of an identifier so you aren’t tempted to analyze it.

Identifier variables themselves don’t tell us anything useful about their categories
because we know there is exactly one individual in each. Identifiers are part of what’s
called metadata, or data about the data. Metadata are crucial in this era of large data
sets because by uniquely identifying the cases, they make it possible to combine data
from different sources, protect (or violate) privacy, and provide unique labels.” Many
large databases are relational databases. In a relational database, different data tables
link to one another by matching identifiers. In the Amazon example, the Customer Num-
ber, ASIN, and Transaction Number are all identifiers. The IP (Internet Protocol) address
of your computer is another identifier, and is needed so that the electronic messages sent
to you can find you.

L ETHICS MATTERS

You have many identifiers: a Social Security number, a student ID number, possibly
a passport number, a health insurance number, and probably a Google account
name. Privacy experts are worried that cyber thieves may match your identity in
these different areas of your life, allowing, for example, your health, education, and
financial records to be merged. Online companies such as Facebook and Google
are able to link your online behavior to some of these identifiers, which carries with
it both advantages and dangers. Did you realize that you are one of the cases in
these data sets? Do you know what they are doing with your indentifying data? The
National Strategy for Trusted Identities in Cyberspace (www.wired.com/images_
blogs/threatlevel/2011/04/NSTICstrategy_041511.pdf) proposes ways that we may
address this challenge in the near future.

Ordinal Variables

A typical course evaluation survey asks, “How valuable do you think this course will be to
you?” 1 = Worthless; 2 = Slightly; 3 = Middling; 4 = Reasonably; 5 = Invaluable. Is
Educational Value categorical or quantitative? Often the best way to tell is to look to the
Why of the study. A teacher might just count the number of students who gave each
response for her course, treating Educational Value as a categorical variable. When she
wants to see whether the course is improving, she might treat the responses as the amount
of perceived value—in effect, treating the variable as quantitative.

But what are the units? There is certainly an order of perceived worth: Higher num-
bers indicate higher perceived worth. A course that averages 4.5 seems more valuable than
one that averages 2, but we should be careful about treating Educational Value as purely
quantitative. To treat it as quantitative, she’ll have to imagine that it has “educational

Swell, maybe three values if you include Zombies.

The National Security Agency (NSA) made the term “metadata” famous in 2014 by insisting that they only
collected metadata on U.S. citizens’ phone calls and text messages, not the calls and messages themselves. They
later admitted to the bulk collection of actual data. In fact, some people say that the NSA is the only goverment
agency that really listens to you.


http://www.wired.com/images_blogs/threatlevel/2011/04/NSTICstrategy_041511.pdf
http://www.wired.com/images_blogs/threatlevel/2011/04/NSTICstrategy_041511.pdf
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value units” or some similar arbitrary construct. Because there are no natural units,
she should be cautious. Variables that report order without natural units are often called
ordinal variables. But saying “that’s an ordinal variable” doesn’t get you off the hook.
You must still look to the Why of your study and understand what you want to learn from
the variable to decide whether to treat it as categorical or quantitative.

EXAMPLE 1.2

Identifying the What and Why of Tablets

RECAP: A Consumer Reports article about 126 tablets lists each tablet’s manufac-
turer, price, battery life (hrs.), the operating system (Android, iOS, or Windows), an
overall quality score (0-100), and whether or not it has a memory card reader.

QUESTION: Are these variables categorical or quantitative? Include units where
appropriate, and describe the Why of this investigation.

ANSWER: The variables are

manufacturer (categorical)

price (quantitative, $)

battery life (quantitative, hrs.)
operating system (categorical)
quality score (quantitative, no units)
memory card reader (categorical)

The magazine hopes to provide consumers with the information that will help them
choose a good tablet.

\

JUST CHECKING

In the 2004 Tour de France bicycle race, Lance Armstrong made history by winning the race for an
unprecedented sixth time. In 2005, he became the only 7-time winner and set a new record for the
fastest average speed—41.65 kilometers per hour—that stands to this day. In 2012, he was banned
for life for doping offenses and stripped of all his titles; in addition, his records were expunged. You
can find data on all the Tour de France races in the data set Tour de France 2020. Here are the first

1. List as many of the W’s as you can for this data set.

three and last nine lines of the data set. Keep in mind that the entire data set has over 100 entries.

2. Classify each variable as categorical or quantitative; if quantitative, identify the units.

Country of Total Time Avg. Speed Total Distance Starting Finishing
Year Winner Origin Age Team (h/min/s) (km/h) Stages Ridden (km) Riders Riders
1903 Maurice Garin France 32 LaFrancaise 94.33.00 25.7 6 2428 60 21
1904  Henri Cornet France 20 Cycles JC 96.05.00 25.3 6 2428 88 23
1905 Louis Trousseller France 24 Peugeot 112.18.09 271 1 2994 60 24
2012  Bradley Wiggins Great Britain 32 Sky 87.34.47 39.83 20 3488 198 153
2013  Christopher Froome Great Britain 28  Sky 83.56.40 40.55 21 3404 198 169
2014 Vincenzo Nibali Italy 29 Astana 89.56.06 40.74 21 3663.5 198 164
2015  Christopher Froome Great Britain 30  Sky 84.46.14 39.64 21 3660.3 198 160
2016 Christopher Froome Great Britain 31  Sky 89.04.48 39.62 21 3529 198 174
2017  Christopher Froome Great Britain 32  Sky 86.34 40.997 21 3540 198 167
2018  Geraint Thomas Great Britain 32  Sky 83.28 40.210 21 3349 176 145
2019 Egan Bernal Colombia 22 INEOS 82.57.00 40.576 21 3365.8 176 155
2020 Tadej Pogacar Slovenia 21 UAE Team Emirates 87.20.05 39.872 21 3482.2 176 146

N\

\




K3 Models

Figure 1.1

A plot of declination against time
shows some patterns. There are
many missing observations. Can you
see the model that Kepler came up
with from these data?
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THERE'S A WORLD OF DATA ON THE INTERNET

These days, one of the richest sources of data is the Internet. With a bit of practice,
you can learn to find data on almost any subject. Many of the data sets we use in this
book were found in this way. The Internet has both advantages and disadvantages as
a source of data. Among the advantages are the fact that often you’ll be able to find
even more current data than those we present. The disadvantage is that references to
Internet addresses can “break” as sites evolve, move, and die.

Our solution to these challenges is to offer the best advice we can to help you
search for the data, wherever they may be residing. We usually point you to a website.
We'll sometimes suggest search terms and offer other guidance.

Some words of caution, though: Data found on Internet sites may not be formatted
in the best way for use in statistics software. Although you may see a data table in
standard form, an attempt to copy the data may leave you with a single column of val-
ues. You may have to work in your favorite statistics or spreadsheet program to refor-
mat the data into variables. You will also probably want to remove commas from large
numbers and extra symbols such as money indicators ($, ¥, £); few statistics pack-
ages can handle these.

What is a model for data? Models are summaries and simplifications of data that help our
understanding in many ways. We’ll encounter all sorts of models throughout the book. A
model is a simplification of reality that gives us information that we can learn from and
use, even though it doesn’t represent reality exactly. A model of an airplane in a wind tun-
nel can give insights about the aerodynamics and flight performance of the plane even
though it doesn’t show every rivet.!® In fact, it’s precisely because a model is a simplifica-
tion that we learn from it. Without making models for how data vary, we’d be limited to
reporting only what the data we have at hand say. To have an impact on science and soci-
ety we’ll have to generalize those findings to the world at large.

Kepler’s laws describing the motion of planets are a great example of a model for
data. Using astronomical observations of Tycho Brahe, Kepler saw through the small
anomalies in the measurements and came up with three simple “laws”—or models for
how the planets move. Here are Brahe’s observations on the declination (angle of tilt to
the sun) of Mars over a twenty-year period just before 1600:
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Figure 1.2

The model that Kepler proposed
filled in many of the missing points
and made the pattern much clearer.

Here, using modern statistical methods, is a plot of the model predictions from the data:

Tycho Brahe’s Mars Observations
The Orbit as Calculated with Modern Methods
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Later, after Newton laid out the physics of gravity, it could be shown that the laws follow
from other principles, but Kepler derived the models from data. We may not be able to
come up with models as profound as Kepler’s, but we’ll use models throughout the book.
We’ll see examples of models as early as Chapter 5 and then put them to use more thor-
oughly later in the book when we discuss inference.

WHAT CAN GO WRONG?

<+ Don’t label a variable as categorical or quantitative without thinking about the data
and what they represent. The same variable can sometimes take on different roles.

¢ Don’t assume that a variable is quantitative just because its values are numbers.
Categories are often given numerical labels. Don’t let that fool you into thinking they have
quantitative meaning. Look at the context.

¢ Always be skeptical. One reason to analyze data is to discover the truth. Even when you are
told a context for the data, it may turn out that the truth is a bit (or even a lot) different. The con-
text colors our interpretation of the data, so those who want to influence what you think may
slant the context. A survey that seems to be about all students may in fact report just the opinions
of those who visited a fan website. The question that respondents answered may be posed in a
way that influences responses.

CHAPTER REVIEW

Understand that data are values, whether numerical or labels, together with their context.

¢ Who, what, why, where, when (and how)—the W’s—help nail down the context of
the data.

¢ We must know who, what, and why to be able to say anything useful based on the
data. The Who are the cases. The What are the variables. A variable gives information
about each of the cases. The Why helps us decide which way to treat the variables.

¢ Stop and identify the W’s whenever you have data, and be sure you can identify the
cases and the variables.
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Consider the source of your data and the reasons the data were collected. That can help
you understand what you might be able to learn from the data.

Identify whether a variable is being used as categorical or quantitative.

¢ Categorical variables identify a category for each case. Usually we think about the
counts of cases that fall in each category. (An exception is an identifier variable that
just names each case.)

¢ Quantitative variables record measurements or amounts of something; they must
have units.

& Sometimes we may treat the same variable as categorical or quantitative depending
on what we want to learn from it, which means some variables can’t be pigeonholed
as one type or the other.

The key terms are in chapter order so you can use this list to review the material in the chapter.

Data
Data table

Context

Case
Respondent
Subject
Participant

Experimental unit

Record
Sample
Population
Variable

Categorical (or qualitative)
variable
Nominal variable

Quantitative variable

Units

Identifier variable

Ordinal variable

Model

Recorded values, whether numbers or labels, together with their context (p. 1).

An arrangement of data in which each row represents a case and each column represents
a variable (p. 3).

The context ideally tells who was measured, what was measured, how the data were collected,
where the data were collected, and when and why the study was performed (p. 3).

An individual about whom or which we have data (p. 4).
Someone who answers, or responds to, a survey (p. 4).
A human experimental unit. Also called a participant (p. 4).
A human experimental unit. Also called a subject (p. 4).

An individual in a study for which or for whom data values are recorded. Human
experimental units are usually called subjects or participants (p. 4).

Information about an individual in a database (p. 4).
A subset of a population, examined in hope of learning about the population (p. 4).
The entire group of individuals or instances about whom we hope to learn (p. 4).

A variable holds information about the same characteristic for many cases (p. 5).

A variable that names categories with words or numerals (p. 6).

The term “nominal” can be applied to a variable whose values are used only to name
categories (p. 6).

A variable in which the numbers are values of measured quantities with units (p. 6).

A quantity or amount adopted as a standard of measurement, such as dollars, hours,
or grams (p. 6).

A categorical variable that records a unique value for each case, used to name or identify
it (p. 7).

The term “ordinal” can be applied to a variable whose categorical values possess some
kind of order (p. 8).

A description or representation, in mathematical and statistical terms, of the behavior of a
phenomenon based on data (p. 9).
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TECH SUPPORT

Entering Data

These days, nobody does statistics by hand. We use tech-
nology: a programmable calculator or a statistics program

on a computer. Professionals all use a statistics package
designed for the purpose. We will provide many examples of
results from a statistics package throughout the book. Rather
than choosing one in particular, we’ll offer generic results
that look like those produced by all the major statistics pack-
ages but don’t exactly match any of them. Then, in the Tech
Support section at the end of each chapter, we’ll provide
hints for getting started on several of the major packages.

If you understand what the computer needs to know to do
what you want and what it needs to show you in return, you
can figure out the specific details of most packages pretty
easily.

For example, to get your data into a computer statistics
package, you need to tell the computer:

» Where to find the data. This usually means directing the
computer to a file stored on your computer’s disk or to data
on a database. Or it might just mean that you have copied
the data from a spreadsheet program or Internet site and it
is currently on your computer’s clipboard. Usually, the data

should be in the form of a data table with cases in the rows
and variables in the columns. Most computer statistics
packages prefer the delimiter that marks the division
between elements of a data table to be a tab character
(comma is another common delimiter) and the delimiter
that marks the end of a case to be a return character.

» Where to put the data. (Usually this is handled

automatically.)

» What to call the variables. Some data tables have variable

names as the first row of the data, and often statistics
packages can take the variable names from the first row
automatically.

» Excel is often used to help organize, manipulate, and

prepare data for other software packages. Many of the
other packages take Excel files as inputs. Alternatively,
you can copy a data table from Excel and paste it into
many packages, or export Excel spreadsheets as tab
delimited (.txt) or comma delimited files (.csv), which
can be easily shared and imported into other programs.
All data files provided with this text are in tab-delimited
text (.txt) format.

DATA DESK

To read data into Data Desk:

» Click the Open File icon or choose File > Open. The
dialog lets you specify variable names (or take them
from the first row of the data), the delimiter, or how to
read formatted data.

» File > Import works the same way, but instead of
starting a new data file, it adds the data in the file to the
current data file. Data Desk can work with multiple data
tables in the same file.

If the data are already in another program, such as, for ex-
ample, a spreadsheet, Copy the data table (including the
column headings). In Data Desk choose Edit > Paste
variables. There is no need to create variables first; Data
Desk does that automatically. You'll see the same dialog
as for Open and Import.

To open a file containing data in Excel:
» Choose File > Open.

» Browse to find the file to open. Excel supports many file
formats.

» Other programs can import data from a variety of file
formats, but all can read both tab delimited (.txt) and
comma delimited (.csv) text files.

» You can also copy tables of data from other sources, such
as Internet sites, and paste them into an Excel spreadsheet.
Excel can recognize the format of many tables copied this
way, but this method may not work for some tables.

» Excel may not recognize the format of the data. If data

include dates or other special formats ($, €, ¥, etc.),
identify the desired format. Select the cells or columns to
reformat and choose Format > Cell. Often, the General
format is the best option for data you plan to move to a
statistics package.
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To import a text file:

» Choose File > Open and select the file from the dialog.
At the bottom of the dialog screen you’ll see Open As: —
be sure to change to Data (Using Preview). This will
allow you to specify the delimiter and make sure the
variable names are correct. (JMP also allows various
formats to be imported directly, including .xls files.)

You can also paste a data set in directly (with or without vari-
able names) by selecting:

» File > New > New Data Table and then Edit > Paste
(or Paste with Column Names if you copied the names
of the variables as well).

Finally, you can import a data set from a URL directly by

selecting:

» File > Internet Open and pasting in the address of the
website. JMP will attempt to find data on the page. It
may take a few tries and some edits to get the data set
in correctly.

To import a text or Excel file:

» Choose File > Open Worksheet. From Files of type,
choose Text (*.txt) or Excel (*.xls; *xlIsx).

» Browse to find and select the file.

» In the lower right corner of the dialog, choose Open to
open the data file alone, or Merge to add the data to an
existing worksheet.

» Click Open.

R can import many types of files, but text files (tab or comma
delimited) are easiest. If the file is tab delimited and contains
the variable names in the first row, then:

> mydata = read.delim(file.choose())

will give a dialog where you can pick the file you want to
import. It will then be in a data frame called mydata. If the file
is comma delimited, use:

> mydata = read.csv(file.choose())

COMMENTS

RStudio provides an interactive dialog that may be easier to
use. For other options, including the case that the file does not
contain variable names, consult R help.

To import a text file:

» Choose File > Open > Data. Under “Files of type,”
choose Text (*.txt,*.dat). Select the file you want to
import. Click Open.

» A window will open called Text Import Wizard. Follow the
steps, depending on the type of file you want to import.

STATCRUNCH

Statcrunch offers several ways to enter data. Click
MyStatCrunch > My Data. Click a dataset to analyze the
data or edit its properties.

Click a data set link to analyze the data or edit its properties
to import a new data set.

» Choose Select a file on my computer,

» Enter the URL of a file,

» Paste data into a form, or

» Type or paste data into a blank data table.

For the “select a file on my computer” option, Statcrunch
offers a choice of space, comma, tab, or semicolon
delimiters. You may also choose to use the first line as the
names of the variables.

After making your choices, select the Load File button at the
bottom of the screen.
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SECTION 1.1

1. Grocery shopping Many grocery store chains offer customers a
card they can scan when they check out, and offer discounts to
people who do so. To get the card, customers must give informa-
tion, including a mailing address and e-mail address. The actual
purpose is not to reward loyal customers but to gather data. What
data do these cards allow stores to gather, and why would they
want that data?

2. Online shopping Online retailers such as Amazon.com keep
data on products that customers buy, and even products they
look at. What does Amazon hope to gain from such
information?

3. Parking lots Sensors in parking lots are able to detect and
communicate when spaces are filled in a large covered park-
ing garage next to an urban shopping mall. How might the
owners of the parking garage use this information both to at-
tract customers and to help the store owners in the mall make
business plans?

4. Satellites and global climate change Satellites send back
nearly continuous data on the earth’s land masses, oceans, and
atmosphere from space. How might researchers use this infor-
mation in both the short and long term to help study changes in
the earth’s climate?

SECTION 1.2

5. Super Bowl Sports announcers love to quote statistics. During
the Super Bowl, they particularly love to announce when a
record has been broken. They might have a list of all Super
Bowl games, along with the scores of each team, total scores
for the two teams, margin of victory, passing yards for the
quarterbacks, and many more bits of information. Identify the
Who in this list.

6. Nobel laureates The website www.nobelprize.org allows you
to look up all the Nobel prizes awarded in Any year. The data
are not listed in a table. Rather you drag a slider to the year and
see a list of the awardees for that year. Describe the Who in this
scenario.

7. Health records The National Center for Health Statistics
(NCHS) conducts an extensive survey consisting of an inter-
view and medical examination with a representative sample of
about 5000 people a year. The interview includes demographic,
socioeconomic, dietary, and other health-related questions. The
examination “consists of medical, dental, and physiological
measurements, as well as laboratory tests administered by
highly trained medical personnel” (www.cdc.gov/nchs/nhanes/
about_nhanes.htm). Describe the sample, the population, the
Who and the What of this study.

8. Facebook. Facebook uploads more than 350 million photos
every day onto its servers. For this collection, describe the Who
and the What.

SECTION 1.3

9.

10.

11.

12.

13.

14.

Grade levels A person’s grade in school is generally identified
by a number.

a) Give an example of a Why in which grade level is treated as
categorical.

b) Give an example of a Why in which grade level is treated as
quantitative.

ZIP codes The U.S. Postal Service uses five-digit ZIP codes to
identify locations to assist in delivering mail.

a) In what sense are ZIP codes categorical?

b) Is there any ordinal sense to ZIP codes? In other words,
does a higher ZIP code tell you anything about a location
compared to a lower ZIP code?

Gay marriage A May 2020 Gallup poll asked, “Do you think
marriages between same-sex couples should or should not be
recognized by the law as valid, with the same rights as tradi-
tional marriages? “Sixty-seven percent of respondents said they
should be valid—a new high in approval. If the choices were
“Should be valid” and “Should not be valid”, what kind of vari-
able is the response?

Gay marriage by party The May 2020 Gallup poll cited in
Exercise 11 also differentiated respondents according to the
political party they identified with. Gallup reports that 83% of
Democrats responded that gay marriage should be recognized,
but only 49% of those self-identifying as Republican did so.
‘What kind of variable is the response percentages Gallup reports?

Medicine A pharmaceutical company conducts an experiment
in which a subject takes 100 mg of a substance orally. The
researchers measure how many minutes it takes for half of the
substance to exit the bloodstream. What kind of variable is the
company studying?

Stress A medical researcher measures the increase in heart
rate of patients who are taking a stress test. What kind of
variable is the researcher studying?

SECTION 1.4

15.

16.

17.

18.

Voting and elections Pollsters are interested in predicting the
outcome of elections. Give an example of how they might
model whether someone is likely to vote.

Weather Meteorologists utilize sophisticated models to predict
the weather up to ten days in advance. Give an example of how
they might assess their models.

The news Find a newspaper or magazine article in which some
data are reported. For the data discussed in the article, identify
as many of the W’s as you can. Include a copy of the article
with your report.

The Internet Find an Internet source that reports on a study
and describes the data. Print out the description and identify as
many of the W’s as you can.


http://www.cdc.gov/nchs/nhanes/about_nhanes.htm
http://www.cdc.gov/nchs/nhanes/about_nhanes.htm
http://www.nobelprize.org/
http://amazon.com/

(Exercises 19-26) For each description of data, identify Who and
What were investigated and the Population of interest.

19.

20.

21.

22,

23.

24.

25.

Gaydar A study conducted by a team of American and Canadian
researchers found that during ovulation, a woman can tell whether
aman is gay or straight by looking at his face. To explore the
subject, researchers recruited 40 undergraduate women who were
not using any contraceptive drugs. These participants were tasked
with guessing the sexual orientation of 80 men based on photos
of their faces. The photographed men were all judged to be
equally attractive and had neutral expressions. The study found
that the closer a woman was to her peak ovulation, the more
accurate were her guesses. https://consumer.healthday.com/
mental-health-information-25/behavior-health-news-56/does-
ovulation-boost-a-woman-s-gaydar-654279.html

Hula-hoops The hula-hoop, a popular children’s toy in the
1950s, has gained popularity as an exercise in recent years.
But does it work? To answer this question, the American
Council on Exercise conducted a study to evaluate the cardio
and calorie-burning benefits of “hooping.” Researchers
recorded heart rate and oxygen consumption of participants,

as well as their individual ratings of perceived exertion, at
regular intervals during a 30-minute workout. (www.acefitness.
org/certifiednewsarticle/1094/)

Bicycle safety Ian Walker, a psychologist at the University of
Bath, wondered whether drivers treat bicycle riders differently
when they wear helmets. He rigged his bicycle with an ultra-
sonic sensor that could measure how close each car was that
passed him. He then rode on alternating days with and without
a helmet. Out of 2500 cars passing him, he found that when he
wore his helmet, motorists passed 3.35 inches closer to him, on
average, than when his head was bare. (Source: NY Times)

Investments Some companies offer 401 (k) retirement plans to
employees, permitting them to shift part of their before-tax salaries
into investments such as mutual funds. Employers typically match
50% of the employees’ contribution up to about 6% of salary. One
company, concerned with what it believed was a low employee
participation rate in its 401(k) plan, sampled 30 other companies
with similar plans and asked for their 401 (k) participation rates.

Honesty Coffee stations in offices often just ask users to leave
money in a tray to pay for their coffee, but many people cheat. Re-
searchers at Newcastle University alternately taped two posters over
the coffee station. During one week, it was a picture of flowers; dur-
ing the other, it was a pair of staring eyes. They found that the aver-
age contribution was significantly higher when the eyes poster was
up than when the flowers were there. Apparently, the mere feeling of
being watched—even by eyes that were not real—was enough to en-
courage people to behave more honestly. (Source: NY Times)

Blindness A study begun in 2011 examines the use of stem cells
in treating two forms of blindness, Stargardt’s disease and dry
age-related macular degeneration. Each of the 24 patients entered
one of two separate trials in which embryonic stem cells were to
be used to treat the condition. (www.blindness.org/index.
php?view=article&id=2514:stem-cell-clinical-trial-for-stargardt-
disease-set-to-begin-&option=com_content&Itemid=122)

Not-so-diet soda A look at 474 participants in the San
Antonio Longitudinal Study of Aging found that participants
who drank two or more diet sodas a day “experienced waist size

26.
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increases six times greater than those of people who didn’t
drink diet soda.” (J/ Am Geriatr Soc. 2015 Apr;63(4):708-15.
doi: 10.1111/jgs.13376. Epub 2015 Mar 17.)

Molten iron The Cleveland Casting Plant is a large, highly
automated producer of gray and nodular iron automotive
castings for Ford Motor Company. The company is interested in
keeping the pouring temperature of the molten iron (in degrees
Fahrenheit) close to the specified value of 2550 degrees.
Cleveland Casting measured the pouring temperature for 10
randomly selected crankshafts.

(Exercises 27-40) For each description of data, identify the W'’s,
name the variables, specify for each variable whether its use indi-

cates that it should be treated as categorical or quantitative, and, for

any quantitative variable, identify the units in which it was measured

(or note that they were not provided).

27.

28.

29,

30.

31.

32.

33.

Weighing bears Because of the difficulty of weighing a bear
in the woods, researchers caught and measured 54 bears, re-
cording their weight, neck size, length, and sex. They hoped to
find a way to estimate weight from the other, more easily deter-
mined quantities.

Schools The State Education Department requires local school
districts to keep these records on all students: age, race or
ethnicity, days absent, current grade level, standardized test
scores in reading and mathematics, and any disabilities or
special educational needs.

Arby’s menu A listing posted by the Arby’s restaurant chain
gives, for each of the sandwiches it sells, the type of meat in
the sandwich, the number of calories, and the serving size in
ounces. The data might be used to assess the nutritional value
of the different sandwiches.

Religious Landscape. The Pew Research Center 2014
Religious Landscape study surveyed a representative sample of
U.S. Adults. Among the questions asked were the respondents’
Age, Gender, Education, Marital Status, Belief in God (certain,
fairly certain, not certain, don’t know, do not believe in God), and
Frequency of Prayer (daily, weekly, monthly, seldom/never).

E-bikes. In May of 2020 Bicycling magazine reviewed elec-
tric bicycles. For each bike reviewed, they reported the motor
size (in watts), maximum speed (mph), wheel base (mm),
brand name, and whether the battery can be removed for secu-
rity. They also provided pictures of each bike.

Flowers In a study appearing in the journal Science, a
research team reports that plants in southern England are flow-
ering earlier in the spring. Records of the first flowering dates
for 385 species over a period of 47 years show that flowering
has advanced an average of 15 days per decade, an indication
of climate warming, according to the authors.

Herbal medicine Scientists at a major pharmaceutical firm
conducted an experiment to study the effectiveness of an herbal
compound to treat the common cold. They exposed each patient
to a cold virus, then gave them either the herbal compound or a
sugar solution known to have no effect on colds. Several days
later they assessed each patient’s condition, using a cold sever-
ity scale ranging from O to 5. They found no evidence of ben-
efits of the compound.


http://www.blindness.org/index.php?view=article&id=2514:stem-cell-clinical-trial-for-stargardt-disease-set-to-begin-&option=com_content&Itemid=122
http://www.blindness.org/index.php?view=article&id=2514:stem-cell-clinical-trial-for-stargardt-disease-set-to-begin-&option=com_content&Itemid=122
http://www.blindness.org/index.php?view=article&id=2514:stem-cell-clinical-trial-for-stargardt-disease-set-to-begin-&option=com_content&Itemid=122
http://www.acefitness.org/certifiednewsarticle/1094/
http://www.acefitness.org/certifiednewsarticle/1094/
https://consumer.healthday.com/mental-health-information-25/behavior-health-news-56/does-ovulation-boost-a-woman-s-gaydar-654279.html
https://consumer.healthday.com/mental-health-information-25/behavior-health-news-56/does-ovulation-boost-a-woman-s-gaydar-654279.html
https://consumer.healthday.com/mental-health-information-25/behavior-health-news-56/does-ovulation-boost-a-woman-s-gaydar-654279.html
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Year Winner Jockey Trainer Owner Time
1875 | Aristides 0. Lewis A. Williams H. P. McGrath 2:37.75
1876 | Vagrant R. Swim J. Williams William Astor 2:38.25
1877 | Baden Baden W. Walker E. Brown Daniel Swigert 2:38
1878 | Day Star J. Carter L. Paul T. J. Nichols 2:37.25
2013 | Orb J. Rosario S. McGaughey | Stuart Janney & Phipps Stable | 2:02.89
2014 | California Chrome | Victor Espinoza | Art Sherman California Chrome, LLC 2:03.66
2015 | American Pharoah | Victor Espinoza | Bob Baffert Zayat Stables, LLC 2:03.03
2016 | Nyquist M. Gutierrez Doug F. O'Neill | Reddam Racing LLC 2:01.31
2017 | Always Dreaming | J.Velazquez Todd Pletcher | Meb Racing Stables 2:03.59
2018 | Justify M. Smith Bob Baffert China Horse Club 2:04:.20
2019 | Country House Flavien Prat Bill Mott J.0. Shields et al, 2:03.93
2020 | Authentic John Velazquez | Bob Baffert Spendthrift Farm and others 2:00.61
L Source: Excerpt from HorseHats.com. Published by Thoroughbred Promotions.

. Vineyards Business analysts hoping to provide information help-

ful to American grape growers compiled these data about vine-
yards: size (acres), number of years in existence, state, varieties of
grapes grown, average case price, gross sales, and percent profit.

Streams In performing research for an ecology class, students
at a college in upstate New York collect data on streams each
year. They record a number of biological, chemical, and physi-
cal variables, including the stream name, the substrate of the
stream (limestone, shale, or mixed), the acidity of the water
(pH), the temperature (°C), and the BCI (a numerical measure
of biological diversity).

Fuel economy The Environmental Protection Agency (EPA)
tracks fuel economy of automobiles based on information from
the manufacturers (Ford, Toyota, etc.). Among the data the
agency collects are the manufacturer, vehicle type (car, SUV,
etc.), weight, horsepower, and gas mileage (mpg) for city and
highway driving.

Dogs detecting coronavirus. In 2020, researchers at the
University of Helsinki studied whether dogs can be trained to
identify coronavirus (COVID-19) by smell. Researchers exposed
dogs who had previously learned to identify cancer by scent to
urine samples from individuals who had either tested positive or
negative for COVID-19. They reported that the dogs were quick
to learn the new scent. (Source: https://www.helsinki.fi/fen/news/
health-news/the-finnish-covid-dogs-nose-knows)

Walking in circles People who get lost in the desert, mountains,
or woods often seem to wander in circles rather than walk in
straight lines. To see whether people naturally walk in circles in
the absence of visual clues, researcher Andrea Axtell tested 32
people on a football field. One at a time, they stood at the center
of one goal line, were blindfolded, and then tried to walk to the
other goal line. She recorded each individual’s gender, height,
handedness, the number of yards each was able to walk before
going out of bounds, and whether each wandered off course to
the left or the right. No one made it all the way to the far end of
the field without crossing one of the sidelines. (Source: STATS
No. 39, Winter 2004)

° 39.

0 40.

Kentucky Derby 2020 The Kentucky Derby is a horse race
that has been run every year since 1875 at Churchill Downs in
Louisville, Kentucky. The race started as a 1.5-mile race, but in
1896, it was shortened to 1.25 miles because experts felt that
3-year-old horses shouldn’t run such a long race that early in
the season. (It has been run in May every year but two—1901—
when it took place on April 29, and 2020, when it was held on
September 5.) The table at the top of the page shows the data
for the first four and eight recent races.

Indy 500 2020 The 2.5-mile Indianapolis Motor Speedway
has been the home to a race on Memorial Day nearly every year
since 1911. Even during the first race, there were controversies.
Ralph Mulford was given the checkered flag first but took three
extra laps just to make sure he’d completed 500 miles. When
he finished, another driver, Ray Harroun, was being presented
with the winner’s trophy, and Mulford’s protests were ignored.
Harroun averaged 74.6 mph for the 500 miles. In 2013, the
winner, Tony Kanaan, averaged over 187 mph, beating the
previous record by over 17 mph!

Here are the data for the first five races and five recent
Indianapolis 500 races.

r 2
Time
Year Driver (hr:min:sec) | Speed (mph)
1911 Ray Harroun 6:42:08 74.602
1912 Joe Dawson 6:21:06 78.719
1913 Jules Goux 6:35:05 75.933
1914 René Thomas 6:03:45 82.474
1915 Ralph DePalma 5:33:55.51 89.840
2015 Juan Pablo Montoya | 3:05:56.5286 161.341
2016 Alexander Rossi 3:00:02.0872 166.634
2017 Takuma Sato 3:13:3.3584 115.395
2018 Will Power 2:59:42.6365 166.935
2019 Simon Pagenaud 2:50:39.27948 175.79362
2020 Takuma Sato 3:10:05.0880 157.824
L J



http://horsehats.com/
https://www.helsinki.fi/en/news/health-news/the-finnish-covid-dogs-nose-knows
https://www.helsinki.fi/en/news/health-news/the-finnish-covid-dogs-nose-knows
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a 41. Kentucky Derby 2020 on the computer Load the Kentucky
Derby data into your preferred statistics package and answer J MS T CH ECK / N G

° 42,

the following questions;

a) What was the name of the winning horse in 18807

Answers

b) When did the length of the race change? 1. Who—Tour de France races; What—year, winner,

¢) What was the winning time in 19747?

country of origin, age, team, total time, average speed,

d) Only one horse has run the Derby in less than 2 minutes. stages, total distance ridden, starting riders, finishing riders;

Which horse and in what year?

Indy 500 2020 on the computer Load the Indy 500 2020 data
into your preferred statistics package and answer the following

How—official statistics at race; Where—France (for the
most part); When—1903 to 2019; Why—not specified
(To see progress in speeds of cycling racing?)

questions: 2. Variable Type Units
a) What was the average speed of the winner in 1920? Year Quantitative  Years
b) How many times did Bill Vukovich win the race in the 1950s? or Identifier
¢) How many races took place during the 1940s? Winner Categorical
Country of Categorical
Origin
Age Quantitative Years
Team Categorical
Total Time Quantitative Hours/minutes/seconds

Average Speed  Quantitative Kilometers per hour
Stages Quantitative Counts (stages)
Total Distance  Quantitative Kilometers

Starting Riders ~ Quantitative Counts (riders)
Finishing Riders  Quantitative Counts (riders)

Real Data Reconstruction

Throughout this course, you will often start with a dataset and then work to analyze it. Let’s reverse
that process and start with a graphic and think about the original data that was needed to produce it.

*
*

Step 1. Find a visualization of data from a reliable news source, available online or in print.

Step 2. Based on the article or surrounding information, detail the full context of the data used
to create the visualization. In particular, list how the data were collected, where they were col-
lected, and when and why they were collected. Make it clear which of these are provided by the
news source. If some context is unavailable, make a guess but indicate that as such.

Step 3. Now, let’s reconstruct the original data set; consider who was measured (rows) and
what was measured (columns). Visualizations provide summaries, so you must consider who or
what one case represents and what variable(s) or characteristic(s) are recorded. Based on the
information provided by the news source, detail what you think the data set looks like by describ-
ing the cases and variables.

Step 4. Lastly, consider the variables or characteristics represented in the visualization. Write a
brief paragraph describing whether the variables are being treated as quantitative variables or
categorical variables. Remember that the visualization may show a percentage of individuals
with a particular characteristic so that you have a numerical summary of a categorical variable.




WHERE ARE WE GOING?

We can summarize and describe data values in
a variety of ways. You'll probably recognize
these displays and summaries. This chapter is
a fast review of these concepts so we all agree
on terms, notation, and methods. We'll be
using these displays and descriptions

throughout the rest of the book.

2.1 Summarizing and Displaying a
Categorical Variable

2.2 Displaying a Quantitative
Variable

2.3 Shape
2.4 Center
2.5 Spread

Table 2.1

Part of a data table showing seven
variables for 11 people aboard the
Titanic.
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Displaying and
Describing Data

hat happened on the Titanic at 11:40 on the night of April 14, 1912, is well

known. Frederick Fleet’s cry of “Iceberg, right ahead” and the three accompany-

ing pulls of the crow’s nest bell signaled the beginning of a nightmare that has
become legend. By 2:15 a.m., the Titanic, thought by many to be unsinkable, had sunk.
Only 712 of the 2208 people on board survived. The others (nearly 1500) met their icy fate
in the cold waters of the North Atlantic.

Table 2.1 shows some data about the passengers and crew aboard the Titanic. Each
case (row) of the data table represents a person on board the ship. The variables are the
person’s Name, Survival status (Lost or Saved), Age (in years), Age Category (Adult or
Child), Sex (Male or Female), Price Paid (in British pounds, £), and ticket Class (First,
Second, Third, or Crew). Some of these, such as Age and Price, record numbers. These are

Name Survived | Age Gender Price Class
ABBING, Mr Anthony LOST 41 Male 7.55 3rd
ABBOTT, Mr Eugene Joseph LOST 13 Male 20.25 3rd
ABBOTT, Mr Rossmore Edward LOST 16 Male 20.25 3rd
ABBOTT, Mrs Rhoda Mary “Rosa” SAVED 39 Female 20.25 3rd
ABELSETH, Miss Kalle (Karen) Marie Kristiane SAVED 16 Female 7.65 3rd
ABELSETH, Mr Olaus Jergensen SAVED 25 Male 7.65 3rd
ABELSON, Mr Samuel LOST 30 Male 24 2nd
ABELSON, Mrs Anna SAVED 28 Female 24 2nd
ABI SA'B, Mr Jirjis Yusuf LOST 45 Male 7.23 3rd
ABI SA'B, Mrs Sha’ninah SAVED 38 Female 7.23 3rd
ABi SHADID, Mr Dahir LOST 19 Male 7.23 3rd




WHO People on the
Titanic

WHAT  Name, survival
status, age, adult/
child, sex, price
paid, ticket class

WHEN  April 14,1912
WHERE North Atlantic

HoW www.encyclopedia-
titanica.org

WHY Historical interest

Titanic 20207?

Why would we put a date
of 2020 on data about an
event that occurred in
19127 Well, although noone
who sailed on the Titanic is
still alive, the dataset is very
much alive. The site
Encylopedia Titanica has
been updating the data and
collecting background
details about the lives of the
people on board since it
first went online in 1996.
Relatives of those on board
and history buffs have been
adding and correcting infor-
mation continuously. One of
our authors has found mis-
takes in the data using
basic statistical methods
you’ll learn in this text.
Those errors have been
corrected at the site and in
our data. Sometimes a sim-
ple display can reveal a
data value that can’t be
right. The data in Titanic
2020 are the best we have
as of the publication of this
book. Perhaps you’ll make
more corrections!

Figure 2.1

How many people were in each
class on the Titanic? From this dis-
play, it looks as though the service
must have been great, since most
aboard were crew members.
Although the length of each ship
here corresponds to the correct

number, the impression is all wrong.

In fact, only about 40% were crew.
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called quantitative variables. Others, like Survival and Class, place each case in a single
category, and are called categorical variables. (Data in Titanic 2020)

The problem with a data table like this—and in fact with all data tables—is that you
can’t see what’s going on. And seeing is just what we want to do. We need ways to show
the data so that we can see patterns, relationships, trends, and exceptions.

The Three Rules of Data Analysis
There are three things you should always do first with data:

1. Make a picture. A display of your data will reveal things you’re not likely to see in a
table of numbers and will help you Think clearly about the patterns and relationships
that may be hiding in your data.

2. Make a picture. A well-designed visualization will Show the important features and
patterns in your data. It could also show you things you did not expect to see: extraor-
dinary (possibly wrong) data values or unexpected patterns.

3. Make a picture. The best way to Tell others about your data is with a well-chosen
picture.

These are the three rules of data analysis. There are pictures of data throughout this
text but these are only the tip of the iceberg, and new kinds keep showing up. These days,
technology makes drawing pictures of data easy, so there is no reason not to follow the
three rules.

We make graphs for two primary reasons: to understand more about data and to show
others what we have learned and want them to understand. The first reason calls for sim-
ple graphs with little adornment; the second often uses visually appealing additions to
draw the viewer’s attention. Regardless of their function, graphs should be easy to read
and understand and should represent the facts of the data honestly. Axes should be clearly
labeled with the names of the variables they display. The intervals set off by “tick marks”
should occur at values that are easy to think about: 5, 10, 15, and 20 are simpler marks
than, say, 1.7, 2.3, 2.9, and 3.5. And tick labels that run for several digits are almost never
a good idea. Graphs should have a “key” that identifies colors and symbols if those are
meaningful in the graph. And all graphs should carry a title or caption that says what the
graph displays and suggests what about it is salient or important.

The Area Principle

A bad picture can distort our understanding rather than help it. What impression do you
get from Figure 2.1 about who was aboard the ship?

Crew

Third

Second |

First



http://www.encyclopedia-titanica.org/
http://www.encyclopedia-titanica.org/
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The Titanic was certainly a luxurious ship, especially for those in first class, but Fig-
ure 2.1 gives the mistaken impression that most of the people on the Titanic were crew
members, with a few passengers along for the ride. What’s wrong? The lengths of the
ships do match the number of people in each ticket class category. However, our eyes tend
to be more impressed by the area than by other aspects of each ship image. So, even
though the length of each ship matches up with one of the totals, it’s the associated area in
the image that we notice. There were about 3 times as many crew as second-class passen-
gers, and the ship depicting the number of crew members is about 3 times longer than the
ship depicting second-class passengers. The problem is that it occupies about 9 times the
area. That just isn’t a correct impression.

The best data displays observe a fundamental principle of graphing data called the
area principle. The area principle says that the area occupied by a part of the graph should
correspond to the magnitude of the value it represents. Violations of the area principle are
a common way to lie (or, since most mistakes are unintentional, we should say err) with
statistics.

EX] Summarizing and Displaying a Categorical Variable

1000

800 —

600 —

# of People

400 —

200 —

1 2 3 Crew
Ticket Class

Figure 2.2

People on the Titanic by Ticket
Class. With the area principle satis-
fied, we can see the true distribution
more clearly.

Frequency Tables

Categorical variables are easy to summarize in a frequency table that lists the number of
cases in each category along with its name.
For ticket Class, the categories are First, Second, Third, and Crew:

Class Count Class Percentage (%)
First 324 First 14.67
Second 284 Second 12.86
Third 709 Third 32.11
Crew 891 Crew 40.35
Table 2.2 Table 2.3
A frequency table of the A relative frequency table for
Titanic passengers. the same data.

A relative frequency table displays percentages (or proportions) rather than the
counts in each category. Both types of tables show the distribution of a categorical
variable because they name the possible categories and tell how frequently each occurs.
(The percentages should total 100%, although the sum may be a bit too high or low if the
individual category percentages have been rounded.)

Bar Charts

Although not as visually entertaining as the ships in Figure 2.1, the bar chart in Figure 2.2
gives an accurate visual impression of the distribution because it obeys the area principle.
Now it’s easy to see that the majority of people on board were not crew. We can also see that
there were about 3 times as many crew members as second-class passengers. And there were
more than twice as many third-class passengers as either first- or second-class passengers—
something you may have missed in the frequency table. Bar charts make these kinds of
comparisons easy and natural.
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EXAMPLE 2.1

Confidence in Congress

In June 2019 the Gallup poll asked a representative sample of U.S. adults how
much confidence they had in various institutions in American society. The response
about Congress was: (https://news.gallup.com/poll/1600/congress-public.aspx)

Great deal 4%
Quite a lot 7%
Some 36%
Very little 48%
None 4%

QUESTION: What kind of table is this? What would be an appropriate display?

ANSWER: This is a relative frequency table because the numbers displayed are
percentages, not counts. A bar chart would be appropriate:

How Much Confidence in Congress
60 —

50 -

40 [~

30 —

Percent

20 —

10 —
e [ s B

Greatdeal ~ Quite a lot Some Very little None

EXAMPLE 2.2

Which Gadgets Do You Use?

In 2014, the Pew Research Organization asked 1005 U.S. adults which of the follow-
ing electronic items they use: cell phone, smartphone, computer, handheld e-book
reader (e.g., Kindle or Nook), or tablet. The results were

4 A
Percentage (%)
Device using the device
Cell phone 86.8
Smartphone 54.0
Computer 775
E-book reader 32.2
Tablet 419
. J

QUESTION: Is this a frequency table, a relative frequency table, or neither? How
could you display these data?



https://news.gallup.com/poll/1600/congress-public.aspx
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FRACTION OF
THIS IMAGE
WHICH |5 WHITE,

FRACTION oF
THIS IMAGE
WHICH 15 BUACK,

© 2013 Randall Munroe. Reprinted with
permission. All rights reserved.

Figure 2.3
Pie charts may be attractive, but it

can be hard to see patterns in them.

Can you discern the differences in
distributions depicted by these pie
charts?

Figure 2.4

Bar charts of the same values as

shown in Figure 2.3 make it much
easier to compare frequencies in

groups.

ANSWER: This is not a frequency table because the numbers displayed are not
counts. Although the numbers are percentages, they do not sum to 100%. A person
can use more than one device, so this is not a relative frequency table either. A bar
chart might still be appropriate, but the numbers do not sum to 100%.

Percentage Using Each Device
100 —

80 —

Percent

20—

Cell phone  Smartphone  Computer E-book reader ~ Tablet

Pie Charts

Pie charts display all the cases as a circle whose slices have areas proportional to each
category’s fraction of the whole.

Pie charts give a quick impression of the distribution. Because we’re used to cutting
up pies into 2, 4, or 8 pieces, pie charts are particularly good for seeing relative frequen-
ciesnear 1/2,1/4, or 1/8.

Bar charts are almost always better than pie charts for comparing the relative frequen-
cies of categories. Pie charts are widely understood and colorful, and they often appear in
reports, but Figure 2.3 shows why statisticians prefer bar charts.

A B c
5
4
25 — 25 — 25 —
20 |- - pujem—— ™ 20 |- -
15 15 15
10 10 10
5 5 5
0 L 0 L 0 L
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Ring Charts

A ring (or donut) chart is a modified form of pie chart that displays only the “crust” of the
pie—a ring that is partitioned into regions proportional in area to each value. You can
think of the ring as the bars of a bar chart stuck end to end and wrapped around the circle.
Ring charts are somewhere between bar charts and pie charts. They may be easier to read
(or not). Judge for yourself:

5, / 5 1 % A
2 4
4 2
4 2
3 3 3
Figure 2.5

Ring charts compromise between pie and bar charts. These ring charts show
the same values as the pie charts in Figure 2.3. Do you find it easier to see the
patterns?

RANDOM MATTERS

Is it random, or is something systematic going on? Separating the signal (the
systematic) from the noise (the random) is a fundamental skill of statistics.

A geoscientist notices that global temperatures have increased steadily during
the past 50 years. Could the pattern be random, or is the earth warming?

An analyst notices that the stock market seems to go up more often on Tues-
day afternoons when it rains in Chicago. Is that something she should bank on?

One of the challenges to answering questions like these is that we have only
one earth and one stock market history. What if we had two? Or many? Some-
times we can use a computer to simulate other situations, to pretend that we have
more than one realization of a phenomenon. In these Random Matters sections,
we’ll use the computer as our lab to test what might happen if we could repeat
our data collection many times.

You probably know that the “rules of the sea” were enforced on the Titanic —
women and children were allowed to board the Titanic lifeboats before the men.
Did ticket class (first, second, or third) also make a difference? Suppose the 712
survivors were chosen at random, giving everyone an equal chance to get into a
lifeboat. Would the distribution have been different? Let’s look. We selected 712
people at random from the list of those aboard the Titanic and made a pie chart of
ticket class. We repeated the random selection 24 times, making a new pie chart
of each selected group of 712 passengers. Among these pie charts in Figure 2.6
we’ve “hidden” the actual distribution of survivors. Can you pick out the real
distribution? If so, then that might convince you that the lifeboats weren’t filled
randomly, with everyone getting an equal chance.



